
 

Quick Reference Guide 

Outlook 2013 for Windows 
Outlook Data Management  

 

 

For software training, contact the Computer Training Center (CTC) at 358-1111 or visit the CTC Web 
site at http://itcd.hq.nasa.gov/ctc. 

This document is posted on the ITCD Web site http://itcd.hq.nasa.gov/ctc. 

There are ramifications for having a “Large” Outlook mailbox and/or “Large” Outlook main folders.  You may experience 

slow response time when opening Outlook, performance issues such as slow sorting or searching, and the inability to send 

e-mail if the mailbox size quota is reached.  The larger the number of items in a folder (Inbox, Sent Items, Deleted Items, 

Calendar, etc.), the greater chance Outlook will send multiple requests to the server if the view is changed or the messages 

are scrolled through.  

Mailbox Size and Maximum Number of Folder Items Quotas 

When discussing the size of a user’s Outlook mailbox, we are referring to the folders on the Exchange Outlook Server 

in your user account, not files stored on your local computer or in a personal storage file.   

Mailbox Size:  1 GB Quota Folder Items:  10,000 Items Quota 

 If the mailbox size reaches 990MB, the user 

will receive notifications the mailbox byte 

count needs to be decreased. 

 If the mailbox size reaches 1 GB, the user 

can still receive e-mail messages but cannot 

send e-mail messages.   

Check Size of Mailbox 

1. Right click on your mailbox in the Folder 

List Navigation.  A shortcut menu displays. 

2. Click Properties.  The Outlook Today 

Properties display.   

3. Click the Folder Size button.  The Folder 

Size dialog box displays (shown below).   

 
4. Click the Server Data tab.  The Total size 

of your mailbox displays as indicated above. 

 When a main folder reaches the maximum, user will receive automatic 

notifications from the Outlook server that a folder contains too many 

items in it. 

 The maximum of 10,000 items includes all of the main folders with all 

their subfolders and contents.  The maximum number of items in any 

of the main Outlook folders should be below 5,000 items.  Ideally, the 

number should be around 3,500 items or less for optimum performance 

Check Number of Items in a Folder 

1. Highlight the folder in the Foldier List Navigation (shown below). 

2. The Number of items displays at the bottom.  

 

 

Create Personal Storage Files (.PSTs) 

A .pst file can be created with unique folders and subfolders to your preferences.  There are differences between an 

Archive and a .pst file.  An Archive exactly mirrors the mailbox, has all the same folders, and the AutoArchive 

processing, when enabled, automatically moves messages based on the AutoArchive settings.  A .pst file, on the 

other hand, is manually maintained by the user, is more flexible in design and can be customized to user preferences. 



Outlook 2013 for Windows QRG:  Outside the Mailbox – Outlook Data Management  Page | 2 

This document is posted on the ITCD Web site http://itcd.hq.nasa.gov/ctc. 

Very large .pst files can become corrupt.  Using multiple .pst 

files for unique projects or by year is recommended.   

1. Click Home | New Items | More Items | Outlook Data File.  

The Create or Open Outlook Data File window displays (shown 

right). 

The Default Save location for PSTs in Outlook 2013 is c:\[user’s 

name]\My Documents\Outlook Files. 

2. In the File name field, type the .pst file name and then click OK.  

The new .pst file appears in the Folder List Navigation. 

Personal Folders are not accessible through Webmail (OWA). 
 

Create .PST File Subfolders 

1. In the Folder List Navigation, right‐click on the .pst file and click 

New Folder (shown near right).  A New Folder field displays in 

the Folder List (shown far right). 

2. In the field provided, type a name for the new .pst subfolder. 

3. Click OK.  The new subfolder will be created and visible in the 

Folder List Navigation. 

4. Click the triangle in front of the .pst file to display the subfolder.     

Move Data Methods 

 Click your mouse on the item to be moved and hold your mouse as you move it to the new location.  Release your mouse to 

drop the item in the new folder location (this method is referred to as “drag and drop”). 

To select multiple items, press CONTROL as you click each item to be moved OR click on the first item to be moved 

and hold SHIFT as you click on the last item to select a group.  To copy instead of move the items, hold CONTROL as 

you click and drag the items to the new folder location. 

 Right‐click the item and select Move from the shortcut menu.  (This is the only way to move an e-mail message while it is 

open.)   A list of most recently used folders displays.  Select the desired folder if listed.  If the desired folder is not listed, 

click Other Folder.  The Move Items dialog box displays.  Select the correct folder location in the Move the selected items 

to the folder list and then click OK. 

 Create rules to move items automatically. (For more Information, documentation on Rules and Filters is available at 

http://nomadinternal.nasa.gov/nomad/documentation.html).  

Backup .PST Files by Exporting 

Once an Outlook item is moved to a .pst file, it is no longer backed up on the Outlook servers; it is, however, backed 

up by Autonomy ConnectedBackupPC.  If you would like to import the .pst file to use in another e-mail client or 

another computer, you need to backup the .pst file.  Most importantly, damaged or lost .pst files are not recoverable, 

therefore, it is strongly recommended that you manually backup your .pst file on a regular basis.  The length of time 

it takes for the backup to complete is dependent on the size of the file and the frequency with which you backup. 

Export .PST Files 

1. Click File | Open & Export |  Import/Export. The Import and Export 

wizard begins (shown right). 

2. Select Export to a file and click Next.  The Export to a file window 

displays prompting you to select the file type. 

3. Select Outlook Date File (.pst).  Click Next.  The Export Outlook Data 

File window displays prompting you to select the folder to export from. 

4. Scroll to and select the .pst file and click the Include Subfolders checkbox 

if desired.  Then click Next.  The Export Outlook Data File window 

displays (shown top of next page) prompting you to enter a file name and 

location. 

5. Specify the location to save your .pst file backup.   It is recommended that 

you save the backup .pst file to your T:\drive. 
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6. Select the option for handling duplicate items (shown right).  As you will 

need to backup on a regular basis, it is recommend you overwrite the 

previous backup file.  In order to ensure there are no duplicate items in the 

backup file, select “Replace duplicates with items exported.” Click 

Finish. You will be prompted to password protect the backup .pst.   

7. Select the desired password protection.   

As the recommended backup .pst file storage location is your T:\drive on 

the server (see step 5 above), a password is unnecessary.  If you create a 

password and then forget the password, you will not be able to access the 

backup .pst file in the future. 

8. Click OK to begin the export process.   
 

While the export is running, you will not be able to do anything in Outlook until it completes. 

Open .PST Backup Files 

Opening a .pst backup file from the network file share (T:\drive) could corrupt the backup file and you could lose 

data.  If you need to open the file in Outlook, copy it to:  C:\Users\YourUserName\My Documents\Outlook Files. 

1. Click File | Open & Export | Open Outlook Data File.  The Open Outlook Data File window displays.   

2. Select the .pst backup file and click OK.  The .pst backup file displays in the Folder List Navigation. 

Search for Items to Delete or Move 

Search Older/Larger Items 

1. Click File | Info | Cleanup Tools | Mailbox Cleanup.  The Mailbox Cleanup dialog 

box displays (shown right).  

2. Select either Find items older than (  ) days or Find items larger than ( ) kilobytes.  

3. Enter the value of days or kilobytes.   

4. Click Find.  The Advanced Find window displays with a search result (shown below in 

the section entitled “Work with Advanced Find Options”). 

 

Use Search Folders to find Large E-mail 

1. From the Folder List Navigation, click the triangle beside Search Folders to expand the 

view.  A number of Outlook saved searches display. 

2. Click Large Mail.  Outlook runs a saved search and displays mail throughout all your 

subfolders sorted by size categories:  Enormous, Huge, Large and Very Large. 

3. Large messages can then be reviewed, deleted or moved to an archive or .pst file.  

Use Outlook Search Tools 

The Search Ribbon is a Tools Tab that is contextual and displays whenever you run a search.  You can enable the 

tab to display all the time.   

1. Click File | Options | Customize Ribbon.   

2. In the Choose commands from drop-down list, select Tool Tabs and select the  

Search Tools tab.  

3. In the Customize the Ribbon drop-down list, select Main Tabs.  

4. Click Add.  The Search Tools will display in the Main Tabs list to the right. 

5. Enable the ribbon by clicking the Search checkbox.  This will enable the Search 

Tab to be available regardless of the context. 

6. Click OK to dismiss the Options window. 
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Work with Advanced Find Options 

1. Click Search Tools Tab | Search Tools | Advanced Find.  

You can also use the shortcut keystroke CTRL + SHIFT + F.  

The Advanced Find window displays (shown right). 

2. Select the type of item you are looking for in the Look field 

drop-down list.  You can search for Appointments and 

Meetings, Contacts, Messages, Notes, or any type of 

Outlook item. 

3. Click Browse to select the folders to include in your search.  

The Select Folders dialog box displays. 

You can search your mailbox, Archive or .pst files if they are 

open in your Outlook Folder List in the Navigation.  However, 

you can only search folders from one data file at a time.  

4. Click the Search subfolders checkbox to search within a group of nested folders.  Otherwise, click to select the 

checkbox for each folder separately. 

5. Click OK.  The Advanced Find window displays again with the In field displaying the selected search folders.  

Depending on what you are looking for (Appointments and Meetings, Contacts, Messages, Notes, or any type of 

Outlook item), the first search tab is contextual and will reflect what you are looking for.  If you are looking for 

Messages, then the first tab will provide options to search for E-mail.  If you are looking for Contacts, then the first 

tab will provide options to search for Contacts.  The following is an example of searching for E-mail messages. 

6. On the Messages Tab (shown right), enter your search criteria: 

 In the Search for the word(s) field, type the search 

keyword(s). 

 In the In field, select subject field only or subject field and 

message body. 

 Click From to select the sender from either the Outlook 

address book or your personal contacts.  You can select 

multiple people.  

 Click Sent To and select the recipient from either the Outlook address book or your personal contacts.  You can select 

multiple people. 

 Click the Where I am checkbox to enable the field, and click the drop-down arrow to select the only person on the 

To line, on the To line with other people, or on the CC line with other people. 

 Click the Time drop-down arrow to select from the list provided.  Options include the time received, sent, due, 

expires, created or modified. 

 Once a time criteria is designated, click the drop-down arrow in the field to select from the list provided.  Options 

include Anytime, Yesterday, Today, In the last 7 days, Last/this week, or Last/this Month. 

7. On the More Choices Tab (shown right), click Categories to 

select a category to search by.   

8. Enable one of the following conditions as appropriate:   

 Only items that are either read or unread. 

 Only items with either one or more attachment, or no 

attachments.  

 Where importance is either normal, high or low.  

 

 Only items which are marked completed, are flagged by someone else, have no flag or are flagged by me. 

 In the Size section, select from the options provided and then enter the size limitations in the two size fields. 
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9. On the Advanced Tab (shown right), create a conditional search 

using multiple search criteria as follows: 

 Click the Field drop-down and select the field type and specific 

field to search within. 

 In the Condition field, select the conditional search operator.  

Options includes contains, is (exactly), doesn’t contain, is empty, 

and is not empty. 

 In the Value field, enter the text to be searched.  

 Click Add to List to add the search criteria into the 

list box.   

 Follow the steps above to continue creating 

conditional search criteria as appropriate.   

 Click Remove to delete conditional search criteria. 

10. Click Find Now to run the search.   Once the search 

completes, the Advanced Find dialog box displays all 

messages that meet the search criteria (shown right).   

From the list box, right-click on a message to display a 

Shortcut Menu with options to Quick Print, Reply, Reply 

All, Forward, Categorize, Move, Delete or Secure. 

 

Automatically Empty Deleted Items  

1. Click File | Options | Advanced.  The Outlook Advanced 

Setting options display. 

2. In the Outlook start and exit section (shown right), select 

Empty Deleted Items folders when exiting Outlook.    
 

Access the Recoverable Items 

If you delete an item and need to restore it to your mailbox, it is available in the Recover Deleted Items list.  

The Recoverable  Items are stored for a period of  two weeks after the deletion date.  

Display the Recover Deleted Items Folder 

1. Display the Deleted Items folder. 

2. Click Folder | Recover Deleted 

Items.  The Recover Deleted Items 

window displays (shown right). 

3. Select items to be recovered.  Multi-

select by pressing SHIFT + click for 

contiguous items or CTRL + click 

for non-contiguous items.  

You can also click the Select All icon.  

 

4. Click Recover Selected Items to 

restore the messages to your 

Deleted Items folder.   

Clicking Delete  in the Recover 

Deleted Items Folder will 

permanently delete the item from the 

Outlook server. 
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Use Outlook 2013 Clean Up Tools  
A conversation or e-mail thread is a chain of e-mail messages with the same subject.  Any messages that are 

duplicated within a later message are considered redundant.  Conversation Clean Up evaluates each message in a 

conversation or message thread.  Any messages duplicated within a later message are moved to the Deleted Items 

folder.  This clean up can be performed on your inbox, a specific mail folder alone or a folder with its subfolders. 

View E-mail Conversations 

1. Display the folder containing the conversations to be viewed.   

2. Click the View Tab | Show as Conversations.  You will be prompted 

to apply the view to All mailboxes, This folders or to Cancel.  

3. Select the appropriate action.  The folder(s) display with triangle 

icons beside the most recent message and all previous messages are 

grouped below it regardless of the folder they are in.   
 

Clean Up by Conversation 

1. Highlight the latest message in a conversation.   

2. Click the Home Tab | Clean Up drop-down arrow | Clean Up Conversation.     

Or Right-click on the message and select Clean Up Conversation.  The Clean Up 

Conversation dialog box displays (shown right). 

You can access the Clean Up Options by clicking Settings on the Clean Up 

Conversation dialog box.    

3. Click Clean Up.  You will be prompted that all redundant messages in this conversation will be moved to the Deleted 

Items folder.   

4. Click OK.  Any messages that are duplicated within a later message will be deleted. 

Clean Up by Folder 

1. Click the Home Tab | Clean Up drop-down arrow | Clean Up Folder or Clean Up Folder and its Subfolders.  The 

Clean Up Folder dialog box displays (shown right).     

You can access the Clean Up options by clicking Settings on the Clean Up 

Folder dialog box. 

2. Click Clean Up Folder.  You will be prompted that the action will be applied 

to the specific folder or to the folder and its subfolders.   

3. Click OK.  Any messages that are duplicated within a later message will be 

deleted.  

Conversation Clean Up Options 

1. To access the options, click Settings on the Clean Up dialog 

box.   

2. OR do the following: 

a. Click the File Tab | Options | Mail.  Scroll down to the 

Conversation Clean Up option settings (shown right). 

b. Click Browse to select the folder for cleaned-up items 

to be moved to.  

3. Select from the additional options below: 

 Enable/disable When cleaning sub-folders, recreate the folder hierarchy in the destination folder. 

 Enable/disable Don’t move unread messages by clicking the checkbox. 

 Enable/disable Don’t move categorized messages by clicking the checkbox. 

 Enable/disable Don’t move flagged messages by clicking the checkbox. 

 Enable/disable Don’t move digitally-signed messages by clicking the checkbox. 

 Enable/disable When a reply modifies a message don’t move the original by clicking the checkbox. 

4. Make your setting selections and click OK. 
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 Work with Archives 

An Archive file is a type of Outlook Data File (.pst). The first time the AutoArchive runs, the Archive file is 

automatically created.  

Archived Folders are not accessible through Webmail or SNA. 

If you choose to have items deleted, they are not archived.  If you choose to have items archived, they cannot be 

deleted by an AutoArchive.  Once items are archived, they can only be deleted manually. 

Create Archive File through File Options  

1. Click File | Options | Advanced | AutoArchive Settings.  The 

AutoArchive dialog box displays (shown right).  

2. Select the checkbox for “Run AutoArchive every [enter value] 

days.”  Once selected, the other options become available.   

3. Choose how often AutoArchive runs.   

It is highly recommended to set the interval to 14 days. 

4. Click “Apply these settings to all folders now” to run the 

AutoArchive process immediately for all folders in your mailbox.   

If you want to set up unique archive options at the folder level do not 

click this button.   

5. Click OK to dismiss the AutoArchive dialog box and then click OK to 

dismiss the Outlook Options window.  The AutoArchive process will 

run based on your selected settings. 

You can also set up these settings by folder.  Simply right-click on 

the appropriate folder in the Folder List Navigation, and click the 

AutoArchive tab.  The same settings will be available.  

Official NOMAD training materials and documentation are available at: 

http://nomad.nasa.gov/nomad/documentation.html 

Help Desk and Center Outreach contact information is available at: 

http://nomad.nasa.gov/nomad/nomadoutreach.html 

For software training, contact the Computer Training Center (CTC) at 358-1111  
or visit the CTC Web site at http://itcd.hq.nasa.gov/ctc 

 


